**What is an Arduino?**

**Open Source**

"Resources that can be used, redistributed or rewritten free of charge. Often software or hardware."

**Electronics**

"Technology which makes use of the controlled motion of electrons through different media."

**Prototype**

"An original form that can serve as a basis or standard for other things."

**Platform**

"Hardware architecture with software framework on which other software can run."

*By Jody Culkin*
Microcontrollers use inputs and outputs. Like any computer, inputs capture information from the user or the environment while outputs do something with the information that has been captured.

An Arduino contains a microchip, which is a very small computer that you can program. You can attach sensors to it that can measure conditions (like how much light there is in the room). It can control how other objects react to those conditions (room gets dark, LED turns on).

A mouse is a common input device for a desktop computer, a monitor is a common output device.

Or it can respond to something as simple as the press of a switch.
Digital information is discrete and finite. All information is described in two states, 1 or 0, on or off.

Analog information is characterized by its continuous nature. It can have an infinite number of possible values.

Inputs and outputs can be digital or analog. Digital information is binary—it is either true or false. Analog information is continuous, it can hold a range of values.

Any object we want to turn on and off and control could be an output. It could be a motor or even a computer.

A switch is a digital input, a sensor is an analog input. The range of an analog sensor is limited by its conversion to digital data.

Momemtary Switch

Force Sensitive Resistor

DC Motor

A switch or a sensor could be an input into the Arduino.
Before we plug in the Arduino, we will review a few terms and principles that have to do with how electricity (and therefore electronics) works.

**Voltage (V)** is a measure of electrical potential. It is measured in **volts**.

**Current (I)** is the amount of flow through a conductive material. It is measured in **amperes** or **amps**.

**Resistance (R)** is a material’s opposition to the flow of electric current. It is measured in **ohms**.

Electricity is the flow of energy through a conductive material.

The speed of flow is determined by **voltage**.

Resistance increases or decreases flow.

Amount of flow moving through pipes is **current**.

The water analogy is commonly used to explain these terms. Here’s one model.
**OHM’S LAW**

Current = Voltage/Resistance  
\[(I = V/R)\]

Or

Resistance = Voltage/Current  
\[(R = V/I)\]

Or

Voltage = Resistance * Current  
\[(V = R*I)\]

There is a relationship between voltage, current and resistance, discovered by Georg Ohm, a German physicist.

For example, increase the resistance, less flow.

Or increase the potential, more flow.

Now let’s look at a simple circuit. Every circuit is a closed loop that has an energy source (battery) and a load (lamp). The load converts the electrical energy of the battery and uses it up. This one has a switch too.

This is a schematic of the same circuit (it represents the circuit using symbols for the electronic components). When the switch is closed, current flows from the power source and lights the lamp.
You'll have to download and install software to program the Arduino. It is available from the URL above, free of charge. The Arduino software runs on the Mac OS X, Windows, and Linux platforms.

Attaching the Arduino to a computer with a USB cable will supply the 5 volts of power we need and allow us to start programming.

Now that we've reviewed some basics of how electricity works, let's get back to the Arduino.

The Arduino will need power to run. We will need to attach it to a computer to program it.

There are two common types of circuits, Direct Current and Alternating Current. In a DC circuit, the current always flows in one direction. In AC, the current flows in opposite directions in regular cycles. We will only talk about DC circuits here.
Launch the Arduino software. In the tools menu, select the board you are using (Tools > Board). For example, Arduino Uno.

Next select the serial port. (Tools > Serial Port) On a Mac it will be something like /dev/tty.usbmodem. On a Windows machine, it will be COM3 or something like that.

For instructions on how to install Arduino software on a Mac:
HTTP://WWW.ARDUINO.CC/EN/GUIDE/MACOSX

For instructions on how to install on Windows:
HTTP://WWW.ARDUINO.CC/EN/GUIDE/WINDOWS

For instructions on how to install on Linux:
HTTP://WWW.ARDUINO.CC/PLAYGROUND/LEARNING/LINUX

When you have installed the software, connect the Arduino. An LED marked ON should light up on the board.
When you downloaded the Arduino software, you downloaded an IDE. It combines a text editor with a compiler and other features to help programmers develop software.

The Arduino IDE allows you to write Sketches, or programs and upload them to the Arduino board. Open the Blink example in the file menu. File > Examples > 1.Basics > Blink.

To upload the sketch to the Arduino board, click the Upload button on the strip of buttons at the top of the window. Some messages will appear in the bottom of the window. Finally, Done uploading.

When you downloaded the Blink example, the LED at pin 13 on the Arduino starts blinking.
void setup() {
// initialize the digital pin as an output.
// Pin 13 has LED connected on most Arduino boards
pinMode(13, OUTPUT);
}

void loop() {
digitalWrite(13, HIGH);   // set the LED on
delay(1000);              // wait for a second
digitalWrite(13, LOW);    // set the LED off
delay(1000);              // wait for a second
}

A SKETCH, LIKE A PROGRAM WRITTEN IN ANY
LANGUAGE, IS A SET OF INSTRUCTIONS FOR THE
COMPUTER. IF WE LOOK CLOSELY AT THE BLINK
SKETCH, WE SEE THERE ARE 2 MAJOR PARTS,
SETUP AND LOOP.

HTTP://ARDUINO.CC/EN/REFERENCE/HOMEPAGE

CHECK OUT THE ARDUINO WEBSITE FOR THE
ARDUINO REFERENCE GUIDE AND MANY OTHER
RESOURCES TO LEARN THE LANGUAGE.

void setup() { //DECLARES BLOCK OF CODE
pinMode(13, OUTPUT); //SETS PIN 13 TO OUTPUT
} //END BLOCK OF CODE

void loop() { //DECLARES BLOCK OF CODE
digitalWrite(13, HIGH); //SETS PIN 13 HIGH
delay(1000);           //PAUSE 1 SECOND
digitalWrite(13, LOW);  //SETS PIN 13 LOW
delay(1000);           //PAUSE 1 SECOND
} //END BLOCK OF CODE

FOR NOW, LET'S LOOK AT THIS SIMPLE SCRIPT LINE
BY LINE & SEE WHAT EACH LINE DOES.
When current flows through a LED (Light Emitting Diode) in the right direction, it lights up. We'll attach an LED to the breadboard, then to the Arduino so we can control it with code.

How do we control objects that are not on the Arduino board? We will connect the Arduino to a SOLDERLESS BREADBOARD. This will allow us to quickly set up and test circuits.

We will connect power and ground from the Arduino board to the vertically connected strips on the left and right with 22 gauge wire. Other components can be attached to the holes in the middle and to power and ground as needed.

This breadboard has 2 rows of holes running down the left and right side, and 5 rows of holes on either side of a middle indentation. The side rows are connected vertically, each row of 5 holes in the middle are connected horizontally.
The LED blinks on for half a second, then blinks off for half a second, over and over again.

Click verify on the menu to check your code. If there aren’t any errors, click upload to put your program on the Arduino.

in setup, we set pin 2 to be an output. in loop, first we set pin 2 high which lights the LED. delay pauses 500 milliseconds, or half a second. when pin 2 is set low, the LED goes off, we pause another half second.

In setup, we set pin 2 to be an output. In loop, first we set pin 2 high which lights the LED. Delay pauses 500 milliseconds, or half a second. When pin 2 is set low, the LED goes off, we pause another half second.

void setup() {
   pinMode(2, OUTPUT);
}

void loop() {
   digitalWrite(2, HIGH);
   delay(500);
   digitalWrite(2, LOW);
   delay(500);
}

The anode is connected to pin 2 on the Arduino through a 220 ohm resistor. The cathode is connected to ground. Pins 2 through 13 can be configured as digital inputs or outputs. Click New button to start a sketch.
Next we'll write the code. In setup, we declare pin 2 an output and pin 4 an input. In loop, we use an if statement. If we read pin 4 as high, we set the LED pin to high, otherwise we set the LED pin to low, turning it off.

```c
void setup() {
    pinMode(2, OUTPUT);
    pinMode(4, INPUT);
}

void loop() {
    if(digitalRead(4)) {
        digitalWrite(2, HIGH);
    } else {
        digitalWrite(2, LOW);
    }
}
```

The LED lights when the switch is held down.
A potentiometer, or pot, is a variable resistor. The amount of resistance changes as it is turned, increasing or decreasing depending on which direction it is turned.

Now we will set up an analog input. We'll use a potentiometer.

First we will look at the range of values we get by turning the pot using the Serial Monitor. In our code, we initialize the serial object in setup, setting a baud rate of 9600. In loop, we read the value from analog pin A0 and print it to the serial object using the println function.

Attach the middle pin on the potentiometer to analog pin A0. Attach one end of the pot to power, the other to ground.

After you have uploaded the script to the Arduino, click the Serial Monitor button in order to see the values as you turn the pot. A window will open, and you will see values ranging from 0 to 1023 as the pot is turned.
Let's use the changing values we receive from the pot as a dimmer to control an LED. Put the LED back into the board, attached to the Arduino at pin 3.

```cpp
int sensorValue = 0;

void setup() {
    pinMode(3, OUTPUT);
}

void loop() {
    sensorValue = analogRead(A0);
    analogWrite(3, sensorValue/4);
}
```

First we create a variable to store the value of the pot. In setup we make pin 3 an output. In loop, we store the value we have read from pin A0 in our variable. Then we write the value to pin 3, our LED pin. We have to divide the variable by 4, so we will have a range of values from 0 to 255, or a byte.

We'll use pulse width modulation (PWM). This is a method of simulating an analog value by manipulating the voltage, turning it on and off at different rates, or duty cycles. You can use PWM with pins 3, 5, 6, 9, 10, and 11.

The brightness of the LED changes, ranging from completely off to very bright as you turn the pot.
THAT'S IT! THIS IS A VERY BRIEF INTRO. IN THE NEXT PANELS, THERE ARE A FEW LINKS AND OTHER RESOURCES. CHECK THEM ALL OUT, YOU'LL FIND LOTS MORE!

LINKS

SOFTWARE

SOFTWARE DOWNLOAD
HTTP://WWW.ARDUINO.CC/EN/MAIN/SOFTWARE

LANGUAGE REFERENCE
HTTP://ARDUINO.CC/EN/REFERENCE/HOMEPAGE

SUPPLIES

MAKER SHED
HTTP://WWW.MAKERSHED.COM/

ADAFRUIT INDUSTRIES
HTTP://ADAFRUIT.COM/

SPARKFUN ELECTRONICS
HTTP://WWW.Sparkfun.com/

JAMECO ELECTRONICS
HTTP://WWW.JAMECO.COM/

TUTORIALS

ARDUINO SITE TUTORIALS
HTTP://WWW.ARDUINO.CC/EN/TUTORIAL/HOMEPAGE

LADY ADA
HTTP://WWW.LADYADA.NET/LEARN/ARDUINO/

BOOKS

GETTING STARTED WITH ARDUINO BY MASSIMO BANZI
MAKING THINGS TALK, SECOND EDITION BY TOM IGOE

PHYSICAL COMPUTING: SENSING AND CONTROLLING THE PHYSICAL WORLD WITH COMPUTERS BY DAN O’SULLIVAN & TOM IGOE

ARDUINO COOKBOOK, 2ND EDITION BY MICHAEL MARGOLIS

ALL TEXT AND DRAWINGS BY JODY CULKIN
FOR MORE, CHECK OUT JODYCULKIN.COM

SPECIAL THANKS TO TOM IGOE, MARIANNE PETIT, CALVIN REID, THE FACULTY AND STAFF OF THE INTERACTIVE TELECOMMUNICATIONS PROGRAM AT NYU, PARTICULARLY DAN O’SULLIVAN, DANNY ROZIN AND RED BURNS. THANKS TO CINDY KARASEK, CHRIS STEIN, SARAH TEITLER, KATHY GONCHAROV & ZANNAH MARSH.

MANY, MANY THANKS TO THE ARDUINO TEAM FOR BRINGING US THIS ROBUST AND FLEXIBLE OPEN SOURCE PLATFORM.

AND THANKS TO THE LIVELY, ACTIVE AND EVER GROWING ARDUINO COMMUNITY.

INTRODUCTION TO ARDUINO BY JODY CULKIN IS LICENSED UNDER A CREATIVE COMMONS ATTRIBUTION-NONCOMMERCIAL-SHAREALIKE 3.0 UNPORTED LICENSE. 2011-2014